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About Hyperion System 9
Hyperion® System™ 9 is a comprehensive Business Performance Management (BPM) system
that consists of these products:

● Hyperion® System™ 9 Workspace™—Management reporting including query and analysis
in one coordinated environment

● Hyperion® System™ 9 Application Builder.NET™—Coordinated planning, consolidation,
and scorecarding applications

● System 9 Foundation Services™ —Used to ease installation and configuration, provide
metadata management, and support a common Microsoft Office interface
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About Workspace
Workspace is a DHTML-based, zero-footprint client that provides the user interface for viewing
and interacting with content created using Hyperion® System™ 9 BI+™ authoring studios and
financial applications:

● Enterprise metrics for management metrics and analysis presented in easy-to-use,
personalized, interactive dynamic dashboards

● Financial reporting for scheduled or on-demand highly formatted financial and operational
reporting from most data sources including Hyperion® System™ 9 Planning™ and
Hyperion® System™ 9 Financial Management™

● Interactive reporting for ad hoc relational queries, self-service reporting, and dashboards
against ODBC data sources

● Production reporting for high volume enterprise-wide reporting

● Web analysis for interactive ad hoc analysis, presentation, and reporting of
multidimensional data

● High performance multidimensional modeling, analysis, and reporting with Hyperion®
System™ 9 BI+™ Analytic Services™

BI+, which includes Analytic Services, is part of a comprehensive BPM system that integrates
the business intelligence platform with financial applications, Hyperion® System™ 9 Smart View
for Office™, and Hyperion® System™ 9 Performance Scorecard™.
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Workspace User Interface
When you log on, the default Workspace start page is displayed. The default is set from the
Preferences dialog, “Setting Preferences” on page 27.
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Table 2 Workspace Elements 

Number Name Description

1 Menu Bar Commands and sub-commands that organize tasks and modules (See “Menus” on page
48)

2 Standard toolbar Buttons for performing tasks (See “Toolbars” on page 44.)

3 View pane Area that provides buttons that enable jumps between panels (each panel having a
specific use and corresponding controls) and displays the list of documents and modules
(Hiding this pane provides a larger content frame in which to use Workspace. Select
View > View Pane to hide and display).

4 View Pane or Content Area Adjuster Setting to adjust the size of the View pane and content area

5 Content area Area in which you view active-module documents, tasks, or files

6 Buttons Buttons for performing module tasks

7 Process bar Location of the current folder, document, or step.

8 Document tab bar Information bar specific to the current module (If multiple documents are open, the
current document tab is highlighted).



Setting Preferences
As a designer, you can set defaults for the general appearance of Workspace user interface,
Explore, studios, and authentication for changing user passwords. Preferences for Planning are
not set from Workspace. For Planning end-user preference settings see the Hyperion System 9
Planning User's Guide and for administrator and application preferences, see the Hyperion System
9 Planning Administrator's Guide. Financial Management preferences are set from the
Workspace, see “Setting User Preferences for Financial Management” on page 69. Default
startup options can be set for the View pane and content area. Some settings can be overridden
through menu options. See Chapter 2, “Setting Preferences and Personalizing Your
Workspace”.
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Note:

Your e-mail address, which you cannot update, defaults to the e-mail address registered in your
user security settings.
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Printing Sections
When you print a section, it is printed to a PDF file and launched inside your browser if the PDF
MIME type is set in your browser. The PDF file can be viewed online, or printed if you need a
hard copy of a report.

The PDF format is created by Adobe and can be viewed outside of your browser if you have
Adobe Acrobat Reader installed. Adobe Acrobat Reader can be downloaded from Adobe’s web
site at http://www.adobe.com/products/acrobat/readstep.html. If the PDF MIME type is not set
in the browser, the browser “Save As” dialog box is invoked.

Note:

A Query section cannot be printed.

➤ To export a document to PDF, select File  > Print via PDF.

Optional: You can also print a section by clicking the Export to PDF icon on the Interactive
Reporting toolbar.

Tip:

Printing a section and Exporting a Section as a PDF are equivalent features.

Exporting Data
Interactive Reporting documents can be exported in several formats, including:

● Exporting a Section as a PDF

● Exporting a Section to MS Excel (.XLS)

● Exporting a Document in Native File Format

Exporting a Section as a PDF
Exporting a section to Portable Document Format (.PDF) allows you to preserve the layout and
format of the original section and transfer it across multiple platforms (such as Windows, Unix
and the Macintosh). It also enables you to save, print and distribute the file easily and effectively.
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To display and print a PDF file you must have Adobe® Acrobat® Reader™ installed. Acrobat
Reader is a self-contained application that can behave as an Internet Browser plug-in or as a
stand-alone application.

Acrobat Reader enables you to view, print and share a PDF file, but does not enable you to create
or modify it. The Acrobat Reader is free and can be downloaded from Adobe’s web site.

When the Acrobat Reader has been installed, you might have to configure your browser to use
it. For example you may need to associate Acrobat Reader as the application to read PDF files,
or have the PDF display in a separate window instead of the same window. You open a PDF file
by double clicking the PDF in the Explore module.

To save a PDF to your desktop for offline viewing, click the Acrobat Reader Save as Copy icon
on the Acrobat Reader toolbar. You are prompted to specify the directory in which to save the
file.

To print a PDF, click the Acrobat Reader Print icon. You are prompted to specify print
parameters and to print the report.

If the Acrobat Reader has not been installed, the File download dialog is displayed. You can save
the file to disk and open it from a location that you specify.

➤ To export a document to PDF, click the Export to PDF icon on the Interactive Reporting toolbar.

Optional: You can also print a document to PDF by selecting File > Print via PDF.

Exporting a Section to MS Excel (.XLS)
You can export a section to Microsoft Excel and launch it inside your browser if the mime type
has been set to recognize the XLS file extension. From this point, you can save the file locally
and work with the data directly in the Microsoft Excel application. If the mime type is not set to
recognize the XLS file extension, you are prompted with a Save As Dialog and must specify a
local destination to save the XLS file for future viewing of the data with the Microsoft Excel.

➤ To export a document to Excel (XLS):

1 Click Export to XLS.

If the mime type has been set to recognize the section, it is launched automatically in Microsoft
Excel.

If the XLS file extension in not recognized, the Save As dialog box is displayed. Complete Step
2.

2 If desired, enter a new name for the section in the File Name field.

3 Select Microsoft Excel Workbook (.XLS) in the Save as Type field.

4 Select Save.
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Results and Tables
When you refresh a query or import data, the Interactive Reporting retrieves data to your browser
and displays it in the Results section. Although the query may have accessed several different
database tables, the results set is displayed as a single table. Each requested item is displayed as
a column in the table and each database record is a row.

Use the Results section to:

● Verify that your query returned the correct information.

● Refine and extend the data set by applying filter conditions or create new computed or
grouped items.

● Sort or use text and column formatting features to enhance the appearance of data results.

● Add summary totals or subtotals and compute them with data functions.

● Print or export the retrieved data to other applications.

All reports, including tables, pivots, charts, are based on the data that is retrieved to the Results
section.

Interactive Reporting provides several ways for you to view the results of a database query for
better analysis:

● Adding a Table

● Working with Columns and Rows

● Sorting Results/Table Items

● Number Formatting

● Applying a Results and Table Filter

● Results and Tables

● Show Values

● Results and Table Totals

● Adding a Computed Item in Results and Tables

● Paging Through Results Data

Adding a Table

➤ To create a table based on data in the Results section:

1 Select Action > Insert > Table.

2 Drag Results items from the Catalog list to the Table Data Layout.
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The table columns are populated automatically.

Working with Columns and Rows
Columns and rows can formatted to your specific needs:

● Adding a Column

● Deleting a Column

● AutoSizing a Column

● Deleting a Row

Adding a Column
If you have removed a column from the results set, you can easily add it back. However, any
data values derived from the re-added column are not automatically update an existing column
either in the results/table section or another section, which draws from the results set.

➤ To add a column:

1 Select any column.

2 Select Add Column on the shortcut menu.

Deleting a Column
You may need to delete a column in order to view the data set in a new way or maybe you want
to concentrate on selected columns of interest. This option is available for all columns. Note
that column deletion should be approached with caution since other sections draw data values
from the results set.

➤ To remove a column, choose the column and select Delete Column on the shortcut menu.

The column is deleted. If you need to add the column back to the Results section, select Add
Column on the shortcut menu.

AutoSizing a Column
By default, Interactive Reporting truncates columns evenly and without regard to the length of
data values. With the auto-size column width feature, you can automatically size any column to
fit the text of the largest value in the column.

➤ To autosize a column:

1 Select a column.

2 Select Auto-Size Column Width on the shortcut menu.
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Deleting a Row
You can delete a row if it is a grand total or break. Note that the grand total is shown in the last
row on the last page of the table.

➤ To delete a row:

1 Select a row.

2 Select Delete Row on the shortcut menu.

Sorting Results/Table Items
Data in the Results section is sorted in the order returned by the database. You can change the
order in which a column is sorted either in ascending or descending order.

➤ To sort a column:

1 Select the column you want to sort on.

Selecting multiple columns invokes a “nested sort.”

2 Select Sort on the shortcut menu.

The Sort submenu is displayed.

3 Select either the Ascending or Descending sort item.

➤ To delete the current sort order:

1 Select any column in the Results or Table section.

2 Select Sort on the shortcut menu.

The Sort submenu is displayed.

3 Select Delete All.

Number Formatting
You can change the way numbers, currency values, and dates are displayed throughout or create
new custom formats.

➤ To apply number formatting, select the format from the Format drop down list box.

Table 55 Formatting Categories

Option Description

Category Select a category for which you want to display number formats. When you select a category, the formats
for that category are displayed in the Format field. To create a custom format, select Custom and enter
the desired format in the Format field. Enter symbols, decimals, commas, and so on to indicate how to
display the format. For example, enter 'MM/DD/YY' to display the date as ̀ 01/01/99', or enter $$#.###.
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Option Description

00 to show two dollar signs before the number and a decimal to mark the thousands' place. When you
create a custom format, it appears as a category on the machine on which it was created. If an item
already has a custom format applied to it, the custom format is in read-only mode.

Format Displays the format for the selected category. If you are creating a custom category, you can enter the
desired format directly in the edit field.

The following table lists available numeric categories.

Table 56 Numeric Categories

Option Description

Number Sets the default format for real or integer values.

Currency Applies currency formatting to the selected number object(s).

Percentage Applied percentage formatting to the selected numeric object.

The following table lists the available formatting options and definitions along with examples
for the above categories.

Table 57 Formatting Options and Descriptions

Option Description Example

0 Integer placeholder or zero value. If a number has an
integer value in this position relative to the decimal
point, the inter is displayed. Otherwise a zero is
displayed.

Apply 0 to show 123.

Apply 0.00 to show 123.45.

# Integer placeholder. If a number has an integer value
in this position relative to the decimal point, the
integer is displayed. Otherwise, nothing is displayed.

Apply #,##0 to show 1,234.

() Formats with parenthesis options display negative
values in parentheses. Otherwise, negative values
are displayed with a minus sign.

Apply (#,###0) to show (1,234).

; A semicolon operates as a separator between two
number formats. The semicolon separates a positive
integer and a negative integer.

Apply #, ##0;(#,##0) to show 1, 234 or apply (1,
234) for a negative number.

$ % Adds the respective character to numeric values in
the same position relative to the decimal point.

Apply $#,##0.00 to show $1,234.56.

Apply 0% to show 3%.

m d yy Displays month, day, and year in respective positions
for date-coded information.

Apply mm dd yy to show 05 07 99

- / Adds the respective character to date-coded values
in the same position relative to variables.

Apply mm/dd/yy to show 06/23/99
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Applying a Results and Table Filter
Because local filters only hide data from the display, they are a good way to filter the data set to
reflect temporary and hypothetical situations. You can always remove the filter to return data
to the display and make it available for reporting.

Applying filters to your results/table sets allows you to narrow your request. That way you can
work with relevant data, saving time and conserving database and server resources.

You can add, modify and remove filters to columns in the Tables/Results section. The column
to which the filter is applied must exist in the table, and a filter cannot be placed on a hidden
column.

See also:

● Show Values

● Custom Values

● Custom SQL

● Modifying a Filter

● Deleting a Filter

➤ To add a results/table filter.

1 Select a column on which to apply the filter.

2 Select Filter on the shortcut menu.

The Filter submenu is displayed.

3 Select Apply/Modify on the Filter submenu.

The Filter dialog box is displayed.

4 Define a pool of the potential filter values by selecting one of the following options:

● “Show Values” on page 247 – Supplies database values associated with the item.

● “Custom Values” on page 248 – Supplies an empty text box for entering custom values.

5 If you are working with the Show Values or Custom Values options, select Include Nulls to include data where
the data item has no value.

Retrieves records where the filtered item has no value; for example, a field in which no data has
been entered. A null value is not equal to zero.

If you are working with the Custom SQL option, skip the remaining steps, enter your Custom
SQL and click Set.

6 Select the NOT check box to negate the operator it precedes.

Selecting NOT reverses the results of the equation.

7 Select a comparison operator to use for filtering values.

For example, if you specify the > Greater Than and then specify a value of 10,000, then values
greater than 10,000 are returned.
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For a list of valid comparison operators, see “Comparison Operators” on page 234.

8 Select the values to apply as a filter.

9 Select Set.

The filter is applied in the Results set.

To suspend a filter temporarily without deleting it, click Ignore.

Show Values
The Show Values feature provides a list of values derived from the content of the Results or Table
section. Because Show Values retrieve every unique value available, it is best not to use this feature
when the data item is large, consists mostly of unique values, or does not change frequently (for
example, telephone numbers). In this situation, custom values are recommended when you want
to avoid extra calls to the database.

The value list that initially displays was saved with the imported Interactive Reporting document,
and it is not the latest value list from the database.

To show the latest value list, select View > Refresh.

➤ To specify a database filter value:

1 Select the Show Values tab.

2 Select Include Nulls to allow nulls to pass the filter and display in the data set.

3 Expand the Operator drop down and select a comparison operator for the filter expression.

Check Not to reverse an operator condition.

For example, if you specify the > Greater Than and then specify a value of 10,000, then values
greater than 10,000 are returned. Values which pass the comparison test are included. Valid
operators include:

Table 58 List of Comparison Operators 

Operator Retrieves Records Where the Filtered Item:

Equal (=) Equals the specified value(s).

Not Equal (<>) Does not equal the specified value(s).

Less Than (<) Less than the specified value(s).

Less or Equal (<=) Equal to or less than the specified value(s)

Greater Than (>); Is greater than the specified value(s).

Greater or Equal (>=); Is equal to or greater than the specified value(s)

Begins With Begins with the specified value(s) up to and including the end value.

Contains Contains the specified value(s) regardless of location.
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Operator Retrieves Records Where the Filtered Item:

Ends With Ends with the specified value(s).

Like (with wildcards) Retrieves records where a text string is displayed and reflects the placement of the specified
value(s).

For example, a Name Like %ZE_ retrieves records for all employees whose names have the
letters Ze followed by a single character at the end

Is Null Has no value; for example a field in which no data has been entered.

Between Retrieves records where the value of the filtered item lies between (and does not equal)
the specified values.

Not (with operator) Negates the operator it precedes, reversing the results of the equation

4 Highlight the values to include as filters from the Values list.

To select an individual value, highlight it in the Values pane.

To select multiple and contiguous values in the Values pane, hold the [Shift] and scroll down
to or up to the items.

To select multiple, but non-contiguous values in the Values pane, hold the [Ctrl] key and
highlight the items.

5 Click Set.

To suspend a filter temporarily without deleting it, click Ignore.

Custom Values
A Custom Values list can be used to set a filter and are created by or supplied to you. One reason
to use custom lists with a distributed document is that many data items change very rarely. For
example, a Gender item has three consistent values (male, female, and unknown). A Product
line item has many more items, but may only change every year or so. Under these circumstances,
it makes sense for you to select from a custom values list.

The initial custom values shown in the values pane originate and are saved with the Interactive
Reporting document.

➤ To apply a custom value as a filter:

1 Select Include Nulls to include data where the data item has no value.

Retrieves records where the filtered item has no value; for example a field in which no data has
been entered. A null value is not equal to zero.

2 Select a comparison operator to use for filtering value.

Select the NOT check box to negate the operator it precedes.

For example, if you select the > Greater Than operator and specify a value of 10,000, values
greater than 10,000 are returned.

For a list of valid comparison operators, see “Comparison Operators” on page 234.
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3 In the Values field, enter the values to which you want to set as a filter.

4 To add the value, click + (the addition sign).

To remove a value from the Values panel, highlight the item in the Values pane and click the -
(subtraction sign).

5 Click Set.

To suspend a filter temporarily without deleting it, click Ignore.

Custom SQL
If you are familiar SQL, select the Custom SQL feature and type a SQL where clause to be included
in the query statement.

➤ To add a custom SQL statement:

1 Select the Custom SQL tab.

2 Type your SQL where clause containing the expression to use for the filter in the Values pane.

3 Click Set.

To suspend a filter temporarily without deleting it, click Ignore.

Modifying a Filter
Once a filter exists for data in your query or results, you can later add or modify filter conditions.

➤ To modify a filter:

1 Select the column to which the filter has been applied.

2 Select Filter on the shortcut menu.

The Filter submenu is displayed.

3 Select Apply/Modify on the Filter submenu.

The Filter window is displayed.

4 Select the filter value and click Set.

The following table provides a quick reference to the Modify Filter option:

Command Description

Set Applies the filter value.

Ignore Filter Ignores a filter without deleting it.

Cancel Cancels any filter applied in the current sessions.
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Deleting a Filter
Deleting a filter adds the original values that were filtered into the data set.

➤ To delete a filter, select the columns that has the filter value to be deleted and select Actions >
Filter > Delete on the shortcut menu.

Results and Table Totals
Totals and subtotals can help to consolidate a large results set. If you need individual data records
and plan to print the Results and Table section as a quick report, add totals and subtotals to
break your report into manageable sections.

See also:

● Calculating a Grand Total for a Column

● Calculating a Break Total for a Column

Calculating a Grand Total for a Column
You can calculate a grand total for any numeric data column and specify the original total value
with a new type of function. For example, by default the totals for a column are sums of the
values in those columns. But you can change the totals to averages instead of sums. These Results/
Table section functions include:

Data Function Returns the:

Sum Sum of all underlying values.

Average Average of all underlying values.

Maximum Highest of underlying values.

Minimum Lowest of underlying values

Count Number of underlying values.
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➤ To apply a grand total to a column:

1 Select the column and choose Grand Total on the shortcut menu.

A submenu showing all available total functions is displayed.

2 Select a total function.

The grand total is displayed in a new row at the bottom of the last page in the selected column.

➤ To remove all grand totals:

1 Select a column to which a grand total was applied and choose Grand Total on the shortcut menu.

A submenu showing all available total functions is displayed.

2 Select Delete All.

➤ To remove a selected grand total:

1 Select the row to which a grand total was applied and choose Grand Total on the shortcut menu.

A submenu showing all available total functions is displayed.

2 Select Delete.

Calculating a Break Total for a Column
You can add subtotals to the same column by choosing another column of non-numeric data
to serve as a “break column.” The break column is used as a reference point to determine where
to break the data in the target column. The data in the subtotal column is subtotaled for each
distinct range of identical values in the break column.

Once a break total is placed on one column, the break total is applied to all numeric columns.

Like the total functions you can use when adding a grand total, a break total can also consist of
different functions. These functions include:

Data Function Description

Sum Sum of all underlying values

Average Average of all underlying values

Maximum Highest of underlying values

Minimum Lowest of underlying values

Count Number of underlying values

➤ To apply a break total:

1 Select the column and choose Break Total on the shortcut menu.

A submenu showing all available break total functions is displayed.

2 Select a total function.
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The default total function is “Sum”.

Break totals are displayed in the target column along with the break total function name.

➤ To delete all break totals:

1 Select the column to which the break total was applied.

2 Select Break Total on the shortcut menu.

3 Select Delete All.

➤ To remove a selected break total:

1 Select the row to which a break total was applied and choose Break Total on the shortcut menu.

A submenu showing all available total functions is displayed.

2 Select Delete.

Adding a Computed Item in Results and Tables
In the Results and reporting sections, computations are performed in the document. The
computations involve only the data in your Results set or on the surface of a reporting section.

In these sections you can only create new computed items: you cannot modify original data
items retrieved directly from the database.

Computed items in the Results and reporting sections differ in two respects:

● In the Results and Table sections, reference items are limited to the items that is displayed
on the Request line.

● In the remaining reporting sections (excluding the Report Designer section), items in any
data layout are available in the Reference dialog box. Computations in these sections work
on the aggregated cell values that make up the core of the report. To perform computations
on data before it is aggregated, compute the new item in the Results section.

● In the Report Designer section, the break totals of a table can be calculated.

➤ To add a computed item in the Results and Table sections:

1 Select an item in the Request pane and choose Actions > Add Computed Item(s).

The Computed Item dialog box is displayed.

2 Enter a name for the computed item in the Name field.

The default name is Computed, which is numbered sequentially if there is more than one. If you
assign a name to a computed item that is identical to an existing scalar function name, Interactive
Reporting numbers the name starting with the number 2.

3 Select the data type of the computed item from the Data Type list box.

For information about data types, see “Adjusting Data Types” on page 232

4 Enter the definition of the computed item in the Definition text box.
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● You can type operators to insert arithmetic and logical operators at the insertion point. See
also “Operators” on page 233.

● Click Reference to display the Reference dialog box, and select items to place in the equation.
See also “Reference” on page 236.

You can also type any portion of the equation or the entire equation directly into the
Definition text box using JavaScript. The names are case sensitive, and you must replace
spaces in item names with underscores (‘_’).

5 When the equation is complete, click OK.

Adjusting Data Types
Since computed items are new data items, confirm or change the data type of the item to preserve
the precision of a mixed-data type computations, or to change the way a data item is handled
(for example, interpreting number as strings). This ensures the correct handling of data in server
computations.

Attention to data types is most important when computing items in the Query section. Here the
computation is performed on the database server, and the computed item may be handled with
an unanticipated data type.

Local calculations (Results or Pivot) are handled internally, and adjustment between 16- and
32-bit integers can be handled safely using the automatic or number data type specification.

Table 59 Data Types in Results and Tables

Data Type Specification

Automatic A data type is determined automatically given the data type of the reference items and the computations
performed

Number Numeric data type.

String Text strings to a maximum length of 256 characters

Date Calendar date in server default format (typically mm/dd/yy)

Picture Picture (Blob) data types for image formats such as: jpeg, bmp, gif, and png.

Paging Through Results Data
By default, Interactive Reporting shows a fixed number of rows in a table when a user views a
page in a browser. Often data extends beyond the vertical and horizontal rows shown on the
page.

Table 60 Results and Table Paging Options  

Paging Option Description

Current Page The tooltip shows the current page in the report.
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Paging Option Description

Page Up Moves one page up. To move to the top page, select [Shift] + Click + Up arrow.

Page Down Moves one page down. To move to the first page in the down direction, select [Shift] + Click + Down
arrow.

Chart Section
Charts are fully interactive, three-dimensional views of data. A chart is a graphical representation
of a Pivot section. With a varied selection of chart types, and an arsenal of tools like grouping,
drill-down and drill to detail, the Chart section is built to support simultaneous graphic reporting
and ad-hoc analysis. You can add, move, cluster, focus and drill down into chart objects to gain
customized views of the data.

● Understanding Chart Dimensions

● Legends

● Chart Types

● Two-dimensional Chart Types

● Multidimensional Chart Types

● Viewing Three-dimensional Bar Charts

Understanding Chart Dimensions
A Chart can be referenced at three points: height, width and depth (x, y and z in Cartesian space).
To understand the differences among charts, you have to distinguish between dimensions in
space and dimensions of data. The two dimensions are distinct.

Data can either be represented in two or in three dimensional space. In two dimensions, data is
represented along the x and y axis. In three dimensions, data is projected back along the z axis.

Two dimensions of data must be represented in two dimensional space. At least three dimensions
of data are necessary to use the third spatial dimension.

But three or more dimensions of data can be represented in two dimensional space. For example,
cluster and stack represent data categories in the bar chart of two spatial dimensions (x and y
axes only).
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Chart Data Layout Categories
The Chart Section opens with an initial plot area for the chart. Because you manage chart
construction and manipulation is with the Chart Data Layout plotting, viewing and reviewing
are easy and intuitive.

You construct a chart by dragging items from the Catalog pane to a Data Layout pane. At least
one items must populate the Data Layout to plot a usable chart.

The Data Layout consists of the following items:

Table 61 Chart Data Layout  

Data Layout Pane Description

X Axis

Slice

The X- Axis is used for those items to place on the x axis, which is a straight line on the chart. It
is used as a qualitative data label for categorizing information. To place items on the x axis, use
the X-Axis pane.

Stack

Cluster

Depth

The Stack Cluster or Depth pane represents the third dimension of data, that is, the z axis that
projects out toward you or a location in space. This axis can either be qualitative or quantitative.

For a Stack pane, each dimension of data of the charts is represented by only one bar. This bar
consists of as many components as the data file has data rows, with the data from each row
stacked onto the previous row. For example, a single bar can represent the amount of sales for
CD-ROM drives in one year on top of a bar representing sales for other years. You can stack the
bar charts vertically or horizontally. By stacking items and assigning a different color to each
item, you can display trends among comparable or related items, or emphasize visually a sum
of several indicators.

For a Cluster pane, data extended in the third dimension is shown as clusters displayed in the
foreground. This category creates a vertical column (and only a vertical column) for each data
value. If the chart is showing multiple data series, the values are grouped based upon the
category value. For example, use clustered bars to compare stores of different types.
Alternatively, cluster bars can be used to compare two different values items, such as Amount
of Sales and Units Sold.

For the Depth, data extends the length of the chart along the z axis.

Fact

Fact (Stack)

The Facts pane indicates height in the coordinate system. It is used as a quantitative label as
a way of categorizing information on the y axis.

Chart Section 255



Data Layout Pane Description

Fact (Depth) For the Fact (Stack) pane, each dimension of numeric data is represented by only one bar. and
shows the grouping along the y axis. This bar consists of as many components as the data file
has numeric rows, with the numeric data from each row stacked onto the previous row. For
example, a single bar can represent the amount of sales for CD-ROM drives in one year on top
of a bar representing sales for other years. You can stack the bar charts vertically or horizontally.
By stacking items and assigning a different color to each item, you can display trends among
comparable or related items, or emphasize visually a sum of several indicators.

For the Fact (Depth) pane, numeric data extends the length of the chart along the z-axis.

Legends
A chart legend can be set on the x, y or z axis enabling you to shift your focus to data listed on
a particular axis. This is a great way to view values on the selected axis without having to view
another chart report.

The following three examples shows how to set the legend on different axes to alter the
appearance and data shown by the same chart.

In the first example, the legend has been set on the x axis:

In the second example, the legend has been set on the y axis:

In the third example, the legend has been set on the z axis:
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➤ To set the chart legend:

1 Select the axis on which to set the legend.

2 Select Set Legend on from the shortcut menu.

The Axes drop-down list box is displayed.

3 Select either the x, y or z axis.

Changing Chart Properties
You can change the properties of a chart to view it in different perspectives:

● Chart Types

● Two-dimensional Chart Types

Chart Types
Chart types are defined by how they represent data graphically and how they plot values and
labels along the x, y or z axes. There are thirteen chart types, each of which may be switched from
a two-dimensional to a three-dimensional view (with the exception of the pie chart). Chart types
include:

● Pie ChartsStacked Bar Charts

● Clustered Bar Charts

● Pie Charts

● Bar Charts

● Scatter Charts

● Bubble Charts

● Area Charts

● Line Charts

● Time Aware Axis

● Ribbon Charts
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● Bar-Line (Combination) Charts

➤ To change a chart type:

1 Select an item on the chart.

2 Select Change Chart Type on the shortcut menu.

3 Select another chart type from the submenu.

Two-dimensional Chart Types
Pie and bar charts (of the non-stacked variety) lend themselves to representing two dimensions
of data. For example, imagine charting the amount of sales by product type. In pie charts, the
two dimensions are represented by slices of a pie. In bar charts, the data is represented by bars
along the x and y axes. Two-dimensional chart types include pie and bar charts.

● Pie Charts

● Scatter Charts

● Bubble Charts

● Bar Charts

Pie Charts
Pieces (slices) of the pie are drawn to depict the relative value of a measurable item category to
the whole. Pie charts represent additional dimensions of data by further subdividing the pie.

Showing Negative and Positive Values

Pie slices can show both positive values and negative values.
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➤ To toggle the display of negative values, select a slice of the pie and select Show Negative
Values on the shortcut menu,

Showing Pie Percent

Pie slice values can be expressed as a percentage.

➤ To toggle the display of each pie slice value as a percentage, select a slice of the pie and choose
Show Pie Percentages on the shortcut menu.

Bar Charts
Bar charts are the most common type of business chart and are especially useful for comparative
analysis when you want to focus on comparing values and place less emphasis on time. Use a
bar chart to illustrate comparisons among individual items.

In a vertical bar chart, items in the y axis form the chart bars. Items in the x axis and z axis itemize
the bars.

In a horizontal bar chart, items in the y axis form the chart bars, and items in the x and z axes
itemize the bars.
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Showing Bar Values

➤ To toggle the display of values, select a bar and choose Show Bar Values on the shortcut menu.

Scatter Charts
A scatter chart is useful for emphasizing scientific or statistical similarities rather than differences
in your analysis. Scatter charts illustrate the relationship between pairs of numerical or
quantitative values, which are combined into individual data points along the horizontal (y axis)
and a vertical (x axis) axis. Data points are plotted in uneven intervals.

A scatter chart represents non-aggregated sources, that is, it retrieves data from the underlying
Table/Reports section and does not reflect rolled up values (all other chart types retrieve their
data from an aggregated source, and there is a one-to one correspondence between Charts and
Pivots). For this reason, the Pivot This Chart feature is not available for a scatter chart.

Scatter charts can only contain a pair of fact or numeric values which are placed in the Y Axis
and X Axis in the data layout. If you add only one fact item to the data layout, no scatter chart
is rendered. In addition, label values cannot be added to the Y Axis or X Axis of the data layout.

The following feature limitations apply to scatter charts:

● Data functions are not available to scatter charts because this type of chart relies on non-
aggregated data.

● The sort feature cannot be used for scatter chart items.

● The Pivot To Chart feature is not available.

● Drilling cannot be performed on a scatter chart.

● The focus feature cannot be used on scatter chart items.

● The Hide feature hides the whole data series in a scatter chart, and an individual item cannot
be hidden.

Bubble Charts
Bubble charts are typically used to show three dimensions of data in a two dimensional chart.
This type of chart often lends itself to the display of financial data because specific values can be
visually represented in your chart by different bubble sizes. It is similar to scatter chart allowing
you to plot data as a collection of bubbles. Bubble charts plot three values:

● a value set on the x-axis

● a value set on the y-axis

● a value that defines the size or width dimension of a bubble in proportion to the amount of
data

Multiple data values can be plotted in the bubble chart.

Bubbles with zero size can rendered using some small bubble size to prevent them from
disappearing. Also there is an option can be provided to hide zero-size values if necessary.
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Bubbles with negative values can also be displayed. These type of values are derived from their
real absolute value, and the real negative value is depicted in the data label (although based on
the positive value). You can optionally select not to show negative values.

The following feature limitations apply to bubble charts:

● Data functions are not available to bubble charts because this type of chart relies on non-
aggregated data.

● The sort feature cannot be used for bubble chart items.

● The Pivot To Chart feature is not available.

● Drilling cannot be performed on a bubble chart.

● The focus feature cannot be used on bubble chart items.

● The Hide feature hides the whole data series in a bubble chart, and an individual item cannot
be hidden.

➤ To create a bubble chart:

1 In the Section pane, select the chart in which to generate the bubble chart.

2 Drag a fact value from the Catalog pane to the Y Axis of the data layout.

3 Drag a fact value from the Catalog pane to the X Axis of the data layout.

4 Drag a fact value from the Catalog pane to the Size pane of the data layout.

➤ To show the real value of a data point, use the tool tip and hover over the data point.

➤ To show grid lines on the scatter chart, click the plot area of the chart and select Show X Axis Grid
Lines or Show Y Axis Grid lines.

Multidimensional Chart Types
Frequently you may want to view data represented in more than two dimensions. For example,
you may want to see how the sales of product types break down by years or quarter. There are
numerous ways to chart three or more dimensions of data. You can project data into the third
dimension of space. You can also represent the data in two spatial dimensions.

● Viewing Three-dimensional Bar Charts

● Clustered Bar Charts

● Stacked Bar Charts

● Area Charts

● Stacked Area Charts

● Line Charts

● Time Aware Axis

● Ribbon Charts

● Bar-Line (Combination) Charts
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Viewing Three-dimensional Bar Charts
You can add more information to your bar chart by adding an additional item or items to the z
axis of the chart. Using multidimensional charts, you can show various relationships between
three or more items in easy-to-understand bar chart formats.

Clustered Bar Charts
Cluster bar charts can be used to juxtapose categories in one label item category. For example,
use clustered bars to compare stores of different types. luster bars can also be used to compare
two different value items, such as Amount of Sales and Unit sold.

You can change your chart perspective so that the z axis data extended in the third dimension
is shown as clusters displayed in the foreground. This charting type is useful when z axis bars
are hard to distinguish in standard bar formats.

Cluster charts can be used to juxtapose categories in one label item. For example, use clustered
bars to compare stores of different types. Alternatively, cluster bars can also be used to compare
two different value items, such as Amount of Sales and Unit Sold.

Clustered bar charts are only displayed in a vertical format.

Stacked Bar Charts
One way to represent the third dimension of data is through stacking. In this way, a single bar
on the chart can show data for more than one category of data. For example, a single bar can
represent amount of sales for CD-ROM drives in one year on top of a bar representing sales for
other years. Stacked bar charts can stack vertically or horizontally.

The following is an example of a vertical stacked bar chart.
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The following is an example of a horizontal stacked bar chart.

Area Charts
Area charts are essentially bar charts with discontinuous breaks removed along the horizontal
axis. Data is not broken into discrete bars, but is displayed in a continuous ebb and flow as
defined against the y axis. Consequently, area charts are particularly useful for emphasizing the
magnitude of change over time. In addition, area charts can be used for the same purpose as bar
charts.

Because area charts do not break data along the horizontal axis, they are most useful for charting
three dimensions of data. The z axis should be used to either project data into a third-spatial
dimension, or to track two categories of data in a stacked area chart.

In the area chart, items in the y pane determine the height of the line, and items in the x pane
itemize the line sections. You can create multiple lines by adding items to the z pane.
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Stacked Area Charts
Stacked area charts are essentially bar charts with the discontinuous breaks removed along the
horizontal axis, and categories of data are “stacked” on top of each other. Data therefore is not
broken into discrete bars, but is displayed in continuous ebb and flow as defined against the y
axis. A stacked area chart is an excellent way to display data that shows the relationship of parts
to the whole. Consequently, stacked area charts can be particularly useful for illustrating changes
that are plotted over a period of time.

Line Charts
Line charts show trends in data at equal intervals and are effective for comparing highs and lows
in a continuum. Items on the y axis determine the height of the line, and items in the X-Categories
itemize the line sections. You can create multiple lines by adding items to the Z-Category.

Line charts have one advantage over bar charts. They do not enable one set of data to obstruct
the representation of another. Since lines are thin compared to bars, the data displayed in the
front does not block out the data behind.

As a result, data that is not easily represented in bar or area charts work well in line charts. Many
more dimensions of data can be superimposed without impairing the effectiveness of the chart.
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Time Aware Axis
The Time Aware Axis feature allows you to show dates in chronological order plotted at specific
intervals within minimum and maximum bounds. To do this, the Time Aware Axis feature turns
a discrete X-Axis into a continuous time interval. The distance between adjacent axis items is
proportional to their time value difference (a non Time Aware Axis shows all items using the
same difference between them). The Time Aware feature only implements an alternative
visualization of source data and does not affect the way how the data is aggregated and computed
items are calculated. That is, the data processing in chart section which includes dividing data
into categories and calculating fact data does not depend on whether the Time Aware feature is
activated. In particular, the behavior of the “Chart This Pivot”, “Pivot This Chart” and “Add
Computed Item” actions do not change.

The Line Charts is the main application area of this feature; however it is available in almost all
existing chart types. Scatter/Bubble charts do not include this option because they are already
“time aware” (essentially, value aware) by nature. Both have two fact axes which are continuous
by definition.

The Time Aware axis can only be used under specific conditions:

● The X axis should have a date/time category to display, which becomes a dedicated Time
Scale category.

● Only one category should be on the X-Axis. If you add multiple categories, even if they are
ate/time categories, the feature is rendered inactive.

● The Time Aware axis is not available for pie, scatter and bubble charts.

The Time Aware Axis is considered active if the conditions in the list above are met, and the
Time Aware option on the Label Axis dialog is not explicitly disabled. You can turn on or off
the feature. If you turn off the feature, the X axis remains discrete as in previous versions. By
default the feature is turned off for Interactive Reporting documents older than Release 9.3.
Charts created in Release 9.3 and later have the feature enabled.
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Note:

Since the Time Aware Axis assumes that all axis labels are in ascending order, the sort order
option is disabled.

➤ To create a Time Aware axis:

1 Check the Time Aware option on the Label Axis tab of General properties.

2 Drag a date/time item from the Catalog pane to the X pane in the data layout.

3 Drag a value item from the Catalog pane to the Facts pane in the data layout.

Ribbon Charts
A ribbon chart is very similar to a line chart, but with a few visual differences. In ribbon chart,
values in the y axis determine the height of the line, and values in the x axis itemize the line
sections. You can create multiple lines by adding items to the z axis.

Bar-Line (Combination) Charts
Bar-Line charts (also known as Combination charts) combine some of the strengths of bar charts
with the advantages of line charts. Solid bars can be used for the most important data against
which other dimensions are represented in lines. In this way, emphasis is give to a portion of
data based on its importance. A combination chart is especially useful for comparing two
numeric values, such as amount and units of sales.
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Note:

A combination chart is most effective when the y axis contains only two value items. It represents
one value as bars and the other value as a line. When more than two values are present, the chart
alternates between bars and lines in depicting the values (1st, 3rd, 5th items are bars; 2nd, 4th,
6th items are lines).

Working with Charted Data
Interactive Reporting provides several ways for you to dynamically manage your chart data for
better analysis. Review the following topics for information on:

● Adding Chart Items

● Removing Chart Items

● Focusing and Hiding Charted Data

● Grouping and Ungrouping Chart Labels

Adding a Chart

➤ To create a Chart based on the Results section data:

1 Select Actions > Insert > Chart.

2 Drag Results items from the Catalog List to the Chart Data Layout.

The table columns are populated automatically.

3 Select a Chart type on the shortcut menu.

Adding Chart Items
Interactive charts consist of two layout elements: graphical elements (for example, Chart bars
or pie slices) and axis labels. When you add items to a chart, they become values or dimensions
in your report.
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➤ To add a chart item:

1 Select a Chart item and choose Add item on the shortcut menu.

The x axis, y axis and z axis submenus are displayed. The z axis submenu does not display for a
pie chart.

2 Select a data label from the x axis submenu.

3 Select a fact item from the y axis submenu.

4 Select a data label item from the x axis (or Z-Cluster for a clustered chart, or Z-Stack for a stacked chart)
submenu to add a third dimension to the chart.

Removing Chart Items
Removing a plotted items in the Chart sometimes helps to simplify a chart display. However,
you do need at least one fact item in order to display a chart accurately.

➤ To remove a chart item:

1 Select the item to be removed in the Chart from the Data Layout.

2 Select Delete on the shortcut menu.

The chart is redrawn to reflect the new configuration of items in the chart.

Refreshing Chart Values Manually
If a Chart section has been designed so that chart values can be refreshed manually, you can
request an immediate refresh to the current section.

➤ To refresh chart values manually, click anywhere on the chart and selectRefresh Chart on the
shortcut menu.

Focusing and Hiding Charted Data
A straightforward way to refresh your view of a chart is to single out items for closer focus or to
hide some of the charted elements. This allows you to concentrate on particular items of interest.

Focusing redraws the chart report to show only the item you have chosen. This feature is only
available for items on the x axis or z axis.

The Show All command updates the chart to include all items removed by focusing. Note that
this command is available only when a Chart item has been focused.

Generally, you should only hide items on the x or z axis. Hiding the y axis causes the entire fact
to be hidden.

The Show Hidden Items command restores any hidden item.
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➤ To focus on a chart item:

1 Select one or more item on which to focus.

The selected items are displayed with a dotted outline.

2 Select Focus on the shortcut menu.

The chart is redrawn to display only the chart item selected.

➤ To show all items in a chart, select a chart item and choose Show Hidden on the shortcut menu.

➤ To hide charted data:

1 In the Chart, select the objects to hide.

The selected item(s) are displayed with a dotted outline.

2 Select Hide Item on the shortcut menu.

The chart is redrawn to hide the item.

➤ To show hidden items, select a chart item and choose Show Hidden on the shortcut menu.

Grouping and Ungrouping Chart Labels
You can merge Chart axis labels using the Group feature. When combined, the data associated
with labels is aggregated, creating a new summary label category. With grouping, only your view
of the data is changed. You can easily ungroup grouped categories and return to your original
label values.

For example, your chart report is structured with data item Units (sold) dimensioned by Year
and Quarter. You can group the first and second quarters together to summarize activity for the
first half of the year. The data is aggregated in a new label.

This feature is available only for items on the x axis or z axis.

➤ To toggle the group axis labels feature:

1 Select the individual labels to be grouped.

(You can group contiguous or discontiguous labels, but the labels must be part of the same
dimension item or axis.)

2 Select (Un)Group Items on the shortcut menu.

The selected labels, and their associated data values or chart objects, are combined. The resulting
label is displayed with an asterisk (*) to indicate a grouping.

To ungroup items, reselect the grouped items and choose (Un)Group Items on the shortcut
menu.
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Working with Chart Facts
Data functions in the Chart section are particularly useful if you want your report to display
different types of values. Data functions summarize groups of database records and replace the
original values with new summary data.

For example, in the Pivot section, you can show either the total sale, average sale, or the maximum
sale of each product by quarter. Each of these dimensions is based on the same underlying values.
They differ only in the data function that is applied.

The following table shows the Chart Functions:

Table 62 Chart Data Functions  

Data Function Returns the:

Sum Sum of all underlying values.

Average Average of all underlying values.

Count Number of underlying values.

Count Distinct Number of distinct values in a column.

Maximum Highest of underlying values.

Minimum Lowest of underlying values

Perc of Grand Sum of underlying values as a percentage of all surface values in the report.

NonNullCount Number of underlying values; null values are excluded.

➤ To apply a data function:

1 Select a bar or row of facts (such as Amount).

2 Select Data Function on the shortcut menu.

A shortcut menu of available data functions is displayed.

Optional: You can also select the item or column and choose Actions > Data Function, and
select the (function).

3 Select the function.

Each column is recalculated according to the data function applied to the underlying value.

Paging Through the Chart
By default Interactive Reporting shows a fixed number of rows in a table when a user views a
page in a browser. Often data extends beyond the vertical and horizontal rows shown on the
page. To view your paging options, see the table below.
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Table 63 Chart Paging Options  

Paging Option Description

Current Page Tooltip shows the current page.

Page Left Moves one view in the left direction. To move to the first view in the left direction, select [Shift] +
Click + left arrow.

Page Up Moves one view up in the Chart sections. To move to the top view, select [Shift] + Click + Up.

Page Down Moves one view in the down direction. To move to the first view in the down direction, select [Shift]
+ Click + Down arrow.

Page Right Moves one view in the left direction. To move to the first view in the right direction, select [Shift] +
Click + right arrow.

Pivot Section
Pivot tables are analytical tools that resemble spreadsheets or crosstab reports. Data can be sliced
and diced for ad-hoc, interactive and multidimensional analysis. You can pivot your data at any
time to change the way you view it, or you may drill down, or drill to detail to see how it all adds
up or summarizes. Pivot tables also allow you to add, move, focus on and group dimensions to
gain customized views of the data.

● Pivot Table Components

● Working with Pivot Data

● Focusing and Hiding Pivoted Data

● Working with Row and Column Labels

● Analyzing Pivot Data

● Working with Pivot Facts

● Paging Through Pivot Data

Pivot Table Components
A pivot table is composed of three components:

● Facts – The numeric values broken up in the body of the pivot table. Facts may also be
referred to as data values.

● Data Labels – The column and row headings on the top and sides of the Pivot and define
the categories by which the numeric values are organized.

● Dimensions – A full row or column of labels.

Pivot Section 271



Working with Pivot Data
Interactive Reporting provides several ways for you to dynamically manage your pivot data for
better analysis:

● Adding a Pivot Section

● ???

● Deleting Pivot Items

● Auto-Sizing a Column

● Focusing and Hiding Pivoted Data

● Swinging Pivot Dimensions

● Grouping and Ungrouping Pivot Labels

Adding a Pivot Section

➤ To create a table based on the Results section data:

1 Select Actions > Insert > Pivot.

2 Drag items from the Catalog list to the Pivot Data Layout.

If the Data Layout is not displayed, select View > Data Layout.

Interactive Reporting populates the cells, rows and columns automatically.

Adding Pivot Items
You can add items from the Results set to view and analyze different scenarios in your Pivot.

➤ To add a pivot item:

1 From the Catalog list, select any item and click Add Items on the shortcut menu.

A shortcut showing Row, Column or Facts is displayed.

2 Select the value you want to add.

Deleting Pivot Items

➤ To delete a pivot item:

1 Select the item to be removed from the Facts, Rows or Columns Data Layout.

2 Select Delete on the shortcut menu.

The Pivot is redrawn to reflect the new configuration of items.
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Refreshing Pivot Values Manually
If a Pivot section has been designed so that pivot values can be refreshed manually, you can
request an immediate refresh to the current section.

➤ To refresh pivot t values manually, click anywhere on the pivot and selectRefresh Pivot on the
shortcut menu.

Auto-Sizing a Column
By default, Interactive Reporting truncates columns evenly and without regard to the length of
data values. With the Auto-Size Column Width feature, you can automatically size any column
to fit the text of the largest value in the column.

➤ To autosize a column:

1 Select the column.

2 Select Auto-Size Column Width on the shortcut menu.

Focusing and Hiding Pivoted Data
A straightforward way to refresh your view of a pivot table is to single out items for closer focus
or to hide some of the pivot elements. This allows you to concentrate on particular items of
interest.

Focusing redraws the pivot table to show only the item you have chosen to focus on.

The Show All Items command updates the pivot table to include all items removed by focusing.
This command is available only when a pivot dimension label has been focused.

Hiding columns is a good way to temporarily suspend the display of a column.

➤ To toggle the focus on a pivot item:

1 Select one or more dimension labels (either side or top).

2 Choose Focus on the shortcut menu.

The Pivot is redrawn to display only the chart object selected.

➤ To show all items, select a dimensional label and choose Show All on the shortcut menu.

➤ To hide pivoted data:

1 Select an item.

2 Select Hide Items on the shortcut menu.

The Pivot is redrawn to hide the selected object.
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➤ To restore a selected hidden item, select a pivot item and choose Show Hidden on the shortcut
menu.

Working with Row and Column Labels
Row and column labels can be grouped and reoriented:

● Grouping and Ungrouping Pivot Labels

● Swinging Pivot Dimensions

Grouping and Ungrouping Pivot Labels
You can merge pivot labels using the Group feature. When combined, the data labels are
aggregated, creating a new summary label category. With grouping, only your view of the data
is changed. You can easily ungroup grouped categories and redisplay original label values.

For example, your pivot table is structured with data item Units (sold) dimensioned by Year
and Quarter. You can group the first and second quarters together to summarize activity for the
first half of the year. The data is aggregated in a new label.

➤ To toggle the group dimensional label feature:

1 Select the individual labels to be grouped.

(You can group contiguous or discontiguous labels, but the labels must be part of the same
dimension item or axis.)

2 Select (Un)Group Items on the shortcut menu.

The selected labels, and their associated data values or chart objects, are combined. The resulting
label is displayed with an asterisk (*) to indicate a grouping.

To ungroup items, reselect the grouped items and choose (Un)Group Items on the shortcut
menu.

Swinging Pivot Dimensions
The swing feature allows you to re-orient the axes of a pivot table and view your data in new
ways. When you “swing” a dimension, you can move it up, down or to the opposite axis. This
feature is a powerful tool that makes pivot table reporting more powerful than a common
spreadsheet.

Note:

You can swing pivot dimensions by moving items within and between Data layout panes,

➤ To swing a dimensional label:

1 Select a dimensional label and choose Swing on the shortcut menu.
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2 Select a direction.

Valid swing positions are:

● Vertical

● Horizontal

● Up

● Down

● Left

● Right

● Before

● After

If you select the “before” swing positions, you must choose the dimension label before which
you wish to place the selected label. This behavior applies to the “after” selection as well.

Working with Pivot Facts
Core numeric data that you slice and dice dimensionally in your analysis are called facts. Facts
can be summed to create totals.

You can calculate totals for both columns and rows in a Pivot report. If you layered dimension
items along the top or side labels of your report, you can calculate the totals for any level in the
hierarchy. When you select an inner dimension for totaling, subtotals are created for each of the
categories in the outer dimensions. Totals in the Pivot section include:

● Total Function

● Cumulative Totals

● Surface Values

Total Function
You can quickly add totals to your pivot table data. The new total value is created as an additional
column. Total functions can be applied to:

● Underlying values from the original results sections

● Surface values displayed in the Pivot

Depending on which set of values you apply the total function, different results are yielded.
Consider a simple pivot table with two values of 20 and 30. Each of these is already a total of
underlying values (20 = 8 +12 and 30 = 10 + 20). An average of the underlying value yields the
result of 12.5 = (8 + 12 + 10 + 20) /4). An average of the surface values yields the results 25 =
(20 +30) / 2).

➤ To add totals to a Pivot:

1 Click a row or column label handle to select it.
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Selecting the outermost label creates a total; selecting an inner label creates a subtotal.

2 Select Add Total on the shortcut menu.

A submenu of data functions is displayed.

3 Select a data function.

Cumulative Totals
By adding cumulative running totals to a pivot table, you can break totals by dimension to restart
at each dimensional grouping in the report.

➤ To add a cumulative calculation:

1 Select a fact item in the data grid of the Pivot.

2 Select Add Cume on the shortcut menu.

The Add Cume shortcut menu is displayed.

3 Select a scope from the Add Cume shortcut menu.

A new data values item named “Cume of X” is displayed across each row of the report. The new
cume item maintains a cumulative running sum of the original data values item.

Note:

Cumulative totals are most effective when all dimensions are located on a row or column of the
report, and data label column heads are placed orthogonally.

➤ To modify a cumulative calculation:

1 Select a column in which a cume has already been place in the pivot table’s data grid.

2 Select Modify Cume on the shortcut menu.

The Modify Cume submenu is displayed.

3 Select a scope from the Modify Cume shortcut menu.

Surface Values
You can use underlying or surface values when working with totals in Pivot sections. Underlying
values refer to values from the original results section. Surface values refers to values in the actual
report section. The two approaches yield different results, and produce values that may be
displayed incongruous with the values in the report.

To understand this difference between underlying and surface values, consider a simple pivot
table with two values of 20 and 30. Each of these is already a total of underlying values (20 = 8
+12 and 30 = 10 + 20). An average of the underlying value yields the result of 12.5 = (8 + 12 +
10 + 20) /4). An average of the surface values yields the results 25 = (20 +30) / 2). By default,
the surface value feature is not active.
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➤ To activate surface values, select a pivot item and Surface Values on the shortcut menu.

Analyzing Pivot Data
Data functions in the Pivot section are particularly useful if you want your report to display
different types of values. Data functions summarize groups of database records and replace the
original values with new summary data.

For example, in the Pivot section, you can show either the total sale, average sale, or the maximum
sale of each product by quarter. Each of these dimensions is based on the same underlying values.
They differ only in the data function that is applied.

Table 64 Pivot Data Functions 

Data Function Returns the:

Sum Sum of all underlying values.

Average Average of all underlying values.

Count Number of underlying values.

Count Distinct Number of distinct values in a column.

Null Count Number of nulls among underlying values.

Non-Null Count Number of underlying values; null values are excluded.

Maximum Highest of underlying values.

Minimum Lowest of underlying values

% of Row Sum of underlying values as a percentage of their respective surface row.

% of Column Sum of underlying values as a percentage of their respective surface column.

% of Grand Sum of underlying values as a percentage of all surface values in the report.

➤ To apply a data function:

1 Select a row or column of facts (such as Amount).

2 Select Data Function on the shortcut menu.

A shortcut menu of available data functions is displayed.

Optional: You can also select the item or column and choose Actions > Data Function, and
select the (function).

3 Select a function.

Each column is recalculated according to the data function applied to the underlying value.
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Paging Through Pivot Data
By default, Interactive Reporting shows a fixed number of rows in a table when a user views a
page in a browser. Often data extends beyond the vertical and horizontal rows shown on the
page. To view your paging options, see the table below.

Table 65 Pivot Paging Options  

Paging Option Description

Current Page The tooltip shows the current page in the report.

Page Left Moves one page in the up direction. To move to the top page, select [Shift] + Click + Up.

Page Up Moves one page in the down direction. To move to the first page in the down direction, select [Shift]
+ Click + Down arrow.

Page Down Moves one page in the left direction. To move to the first page in the right direction, select [Shift]
+ Click + right arrow.

Page Right Moves one page in the left direction. To move to the first page in the left direction, select [Shift] +
Click + left arrow.

Common Chart/Pivot Features
Interactive Reporting document management features allow you to easily tailor the look of
reports. The features shown below are common in the Chart and Pivot sections:

● Sorting Charts/Pivots

● Drill Anywhere into Charts/Pivots

● DrillDown into Dimensional Data

Sorting Charts/Pivots
In the Chart and Pivot sections, data is sorted alphabetically. You can override this default and
sort dimensional data with reference to other data, rather than alphabetically.

For example, if a chart lists each type of item your company sells and the total amount sold of
each, initially the item types are alphabetically ordered. But this data becomes more meaningful
when you instead sort the item types with reference to the total sales revenue produced by each.
This approach allows you to rank each product type from highest to lowest total sales.

When you want to apply a sort criteria there are three components used to define the sort
condition:

● Sort Items – Consists of those items that can be sorted in ascending or descending order. In
the Chart section, sort items refers to the chart axes. In the Pivot section, sort items refers
to the pivot dimensions.

278 Interactive Reporting



● Referential Items – Refers to the numeric data item included in the Chart or Pivot section,
and also the keyword “labels.” These selections provide two ways to sort the selected Chart
or Pivot item.

❍ Sorting by labels – Dimensional data items are sorted alphabetically by name when the
chart section is created: this is equivalent to sorting by “labels.” When selected, the
“labels” keyword simply indicates that the item chosen from the submenu are sorted by
label or name, rather than by reference to corresponding numeric data values in the
report.

❍ Sorting by values – Sorting by a numeric data item orders each value of the target item
specified by its corresponding numeric value in the second list. Sorting by values
produces an entirely different sort order. For example, your chart may list each state in
which your company has made sales revenue and the total cost-of-sales for each. The
data items are initially listed in alphabetical order, that is, sorted by “labels.” When you
sort instead by cost-of-sales, the states are ranked in order by each corresponding cost-
of-sales figure.

● Functions – Refers to aggregate statistical functions available when you sort by values. The
functions generally duplicate the data functions available in the chart section.

When you sort by values, dimensional data is sorted by the corresponding numeric values of the
referenced item. (For example, sorting states by the sum total of the cost of good sold in each
state).

➤ To specify a sort:

1 Select an item to sort in the Chart or Pivot sections.

2 Click either Sort Ascending or Sort Descending on the shortcut menu.

3 Select Label to sort the item alphabetically, or select the numeric value item as a sort reference.

4 If you selected a numeric value, choose an aggregate function on the shortcut menu.

Drill Anywhere into Charts/Pivots
The Drill Anywhere feature allows you to drill into and add items in the Chart and Pivot sections
that are resident in the Results section, but have not been included in the Chart and Pivot you
are viewing. Drill anywhere items are broken out as a new label item(s) automatically. The
advantage of this feature is that it instantly allows you to add items to the data set to reflect
temporary and hypothetical situations.

The extent to which you can drill into your data depends on how the original query was built,
since Drill Anywhere retrieves data from the Results section.

➤ To drill anywhere into a Chart:

1 Select a pivot dimension or chart item for analysis.

2 Select Drill Anywhere on the shortcut menu.

A shortcut of drill anywhere items displays.
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3 Select an item on which to drill down.

The report is redisplayed, breaking out the additional data as a new label item.

Note:

If no options are available in the Drill Anywhere drop down list, all available items have been
referenced in the chart.

DrillDown into Dimensional Data
The DrillDown feature enables you to use a predefined drill-down path to go directly to the next
item in a hierarchy when working with dimensional analysis. For example, you may need to find
out if a particular product sells better in different regions of the country. Using a drill-down
path, all you have to do is follow the drilldown path to discover which state or even city is a more
appropriate market for your product.

➤ To drill down into a Pivot or Chart label:

1 Select any label for drill-down analysis.

Because the drill-down into feature is not context sensitive, access the drill-down from any label
shown.

2 Click Drilldown into on the shortcut menu.

All available drill-down paths are displayed. Each drill-down path shows the topic which is being
drilled into, and the label from which it was drilled.

3 Click the drill-down label.

After you specify the drill down label, the label is added to the Data Layout and breaks out the
additional data according to the label selected for drill-down.

➤ To drill up from data:

1 Click the label that has been drilled downed.

2 On the Pivot or Chart menu, select Drill Up.

The report is redisplayed, reversing the drill-down and displaying the original item.

●

●

280 Interactive Reporting


	Contents
	Using Workspace
	About Hyperion System 9
	About Workspace
	Workspace User Interface
	Setting Preferences

	Interactive Reporting
	Exporting Data
	Exporting a Section as a PDF
	Exporting a Section to MS Excel (.XLS)
	Exporting a Document in Native File Format

	Results and Tables
	Adding a Table
	Working with Columns and Rows
	Sorting Results/Table Items
	Number Formatting
	Applying a Results and Table Filter
	Results and Table Totals
	Adding a Computed Item in Results and Tables
	Paging Through Results Data

	Chart Section
	Understanding Chart Dimensions
	Chart Data Layout Categories
	Legends
	Changing Chart Properties
	Working with Charted Data
	Refreshing Chart Values Manually
	Focusing and Hiding Charted Data
	Grouping and Ungrouping Chart Labels
	Working with Chart Facts
	Paging Through the Chart

	Pivot Section
	Pivot Table Components
	Working with Pivot Data
	Focusing and Hiding Pivoted Data
	Working with Row and Column Labels
	Working with Pivot Facts
	Analyzing Pivot Data
	Paging Through Pivot Data

	Common Chart/Pivot Features
	Sorting Charts/Pivots
	Drill Anywhere into Charts/Pivots
	DrillDown into Dimensional Data




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.5
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile (None)
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /SyntheticBoldness 1.000000
  /Description <<
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /FRA <>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /ENU <FEFF005500730065002000740068006500730065002000730065007400740069006e006700730020007700680065006e0020007300750062006d0069007400740069006e006700200074006f002000410053004d002000610074000d004800650077006c006500740074002d005000610063006b006100720064002e002000540068006500730065002000730065007400740069006e006700730020007200650071007500690072006500200066006f006e007400200065006d00620065006400640069006e0067002e>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




